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Abstract: This document introduces users to basic Excel tasks, such as
creating, saving, and opening new Excel workbooks and
worksheets; selecting, copying, and moving data; constructing
formulas; formatting worksheets; and setting up worksheets for
printing. It is used in conjunction with the ACS Excel
Introduction workshop.
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Introduction

Excel is a spreadsheet that allows users to create worksheets in that store information in
workbook files. The built-in functions allow users to also create and edit formulas; copy
and move data; format worksheets; and set up worksheets for printing.

Objectives

The goal of this workshop is to introduce participants to the introductory commands and
features of the Excel program. After today's workshop, participants will be able to:

e Create, open, and save Excel workbooks

e Select, copy, and move data

e Create formulas using relative and absolute references
e Format worksheets

e Use Page Setup to set up worksheets for printing

Prerequisites

It is assumed that the participants in this workshop have basic computing skills and know
how to use the Macintosh or Windows operating system to maintain files and
directories/subdirectories, open, close, and save files.

Related Training Available from ACS

All ACS workshops are free to KU students, staff, faculty, and approved affiliates. The
general public is also welcome to most workshops, but some ACS workshops require a

registration fee for them.

To learn more about or register for workshops, receive automatic announcements of
upcoming workshops, and track workshops you’ve registered for and have attended, visit
the ACS Web site at www.ku.edu/acs/train. You can also check our online schedule at
www.ku.edu/acs/schedule for a list of class offerings and their availability. For further
workshop related questions, please email training@ku.edu.

EXCEL: CHARTING

This three-hour, hands-on workshop introduces using Excel to create and edit charts,
modify chart options, format chart objects, as well as use trend lines, forecasts, and error
bars to present data graphically. In addition, students will learn to insert Excel charts in
other programs like PowerPoint or Word.
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Definitions
Term Definition
Active Cell | A cell that is selected.
Cell Cells form where rows and columns intersect. To refer to a cell, enter

the column letter followed by the row number. For example, C15 refers
to the cell at the intersection of column C and row 15.

Workbook In Excel, a workbook is the file in which you work and store your data.
Because each workbook can contain many sheets, you can organize
various kinds of related information in a single file. By default, all new
workbooks contain three worksheets.

Worksheet | Worksheets consist of cells that are organized into alphabetical labeled
(Spreadsheet) | columns and numerically labeled rows and are always located within
workbooks. They are used to list, organize, and calculate data.
Information can be linked from one worksheet to another in the same
workbook or in different workbooks.

Creating and Opening Excel Workbooks
Opening Excel

When you first open the Excel program, a new workbook (Book1) will be created
automatically with three worksheets. Each worksheet will be labeled Sheetl, Sheet2, and
Sheet3. Worksheet tabs can be found at the bottom of the workbook window. To move
from sheet to sheet, you can click the sheet tabs.

Each worksheet contains 65,536 rows and 256 columns. The columns are labeled
alphabetically and run along the top of the worksheet. The rows are labeled numerically
and run along the left side of the worksheet. Columns are labeled A through Z, AA
through AZ, BA through BZ, etc. Rows are numbered from 1 through 65,536. A cell
forms where these rows and columns intersect. The scroll bars on the right and along the
bottom of the worksheet can be used to scroll to any location of the worksheet.
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With Excel Open

If you already have Excel open and want to create a new plain workbook, you can click
on the New button. [ If you want to create a new workbook from a template, you can
click on File=»New fo see Excel’s built in templates or custom templates.

Hew EE

General | Spreadsheet Solutions |

W 5

—Preview

Palmapp

Preview not available,

(] 4 I Zancel
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Opening An Existing Workbook
You can always opening existing workbook files as well. To do this:

1. Click on File=»Open or click on the yellow Open folder g on the Standard toolbar.

Open EE
Look in: II:l Excel 97 j = | @ v + Tools -

Excel Funchions and Data Analysis Tools
Intermediate

File: marne: I j = oOpen |
Web Folders '
Files of bvpe: I.ﬁ.ll Microsaft Excel Files (*,x*; * xls; *.xk; *. bk *,heml; 5= Cancel |

2. Change the folder (if needed) to find the file you want.

3. Select the file name and double click on it or click on the Open button.

Inside an Excel Worksheet

Pointer Appearances

In an Excel spreadsheet, your pointer appearance will change dependent upon where you
are in the worksheet. It is important to understand the distinction between these mouse

pointer types:
Name Appearance Description

Cross (Puffy Plus): '{ll:' Used to select a cell or a range of cells.

I-Beam: I When you see an [-Beam, click one time for a blinking
insertion point that will allow you to type in text.

Mouse Pointer: [:g The pointer is this shape when using toolbars, moving
and resizing windows, and when moving or copying
information from cells.
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Selecting Parts of a Worksheet

There are lots of reasons to select, or click, in different areas of your workbook. We
select cells to enter, change, and delete information. We select cells for formulas to
reference. We also select cells to format their contents. Any time we select a cell, we
call it an active cell.

Using the Mouse

Here are many ways to make a cell active by clicking or clicking and dragging with your

mouse:
Item Selected How to Select

Cell Click on the cell.

Cell Range Use the Cross (Puffy Plus) to click and
drag across the group of cells.

Row Click on the row number.

Column Click on the column letter.

Multiple Rows Click and drag down the row numbers.

Multiple Columns Click and drag across the column letters.

Entire Worksheet Click the gray cell between column A and
row 1.

Non-Contiguous Cells | Select the first cell or range of cells and
then hold down the Ctrl key while
selecting the remaining cells.

Using the Keyboard

The keyboard is also a great way to move around inside of Excel workbooks and
worksheets. Here are just a few common keystrokes or keyboard shortcuts:

Key Direction
Enter Moves the active cell down, row to row.
Tab Moves the active cell to the right, column to column.
Shift/Enter Moves the active cell up, row to row.
Shift/Tab Moves the active cell to the left, column to column.
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Ctrl/Home Moves the active cell to Al.

Ctrl/End Moves the active cell the last cell that contains data.

Ctrl/Page Down | Moves from one worksheet to another.

& Ctrl/Page Up

F2 key (function | Opens the active cell for you to edit the data in it.
key)

Alt/Enter Enters a hard return inside of the active cell. This

will automatically wrap your text and increase the
size of the cell.

Cell Contents

Text

In Excel, you can enter four types of values: text, numbers, dates and times, and
formulas. Each cell can hold up to 32,767 characters.

In Excel, text is any combination of numbers, spaces, and nonnumeric characters. All
cells that Excel considers to be text will be left aligned. In the following example, these
entries would be treated as text:

1025A63N; 123XYZ; 10-72; 123 456.

Numbers

Numbers include the numeric characters 0-9 and the following special characters:
,+-()/Ee$%.

If a number is wider than the cell, ######## is displayed. To display the cell contents,
resize the column. Excel stores numbers up to 15 digits of accuracy. The largest positive
number is 9.99999999999999E307 and the smallest positive number is 1E-307. By
default, negative numbers are preceded by a minus sign. However, they can be formatted
to be enclosed in parenthesis or displayed in red. Entering a dollar sign ($) before a
number or a percent (%) symbol after changes the display of the number.

Dates and Times

Excel treats dates and times as numbers. They can be displayed in several built-in
formats. The way that a time or date is displayed on a worksheet depends on the number
format applied to the cell. When a date or time is entered into a cell, Excel automatically
changes the cells format from general to a built in date or time format. By default, dates
and times are right aligned in a cell. If Excel cannot recognize the date or time format, the
date or time is entered as text, which is left aligned in the cell. Date and time can be
mixed into one cell, however slashes and hyphens cannot be mixed in one entry. To type
a date and time in the same cell, separate the date and time with a space.
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To type a time based on the 12-hour clock, type a space followed by AM or PM (or A or
P) after the time. Otherwise, Excel bases the time on the 24-hour clock. For example, if
you type 3:00 instead of 3:00 PM, the time is stored as 3:00 AM.

Times and dates can be added, subtracted, and used in other calculations. To use a date or
time in a formula, enter the date or time as text enclosed in quotation marks. For
example, the following formula would display a difference of 68:

="5/12/94"-"3/5/94"

Some examples of date and time formats:

Date/Time Entry Format
6/9/01 m/d/y
9-June-01 dd-mmmm-yy
June-01 mmmm-yy
9-June dd-mmmm
7:00 AM h:mm AM/PM
7:00:00 AM h:mm:ss AM/PM
18:00 h:mm
6/9/01 7:00 m/dd/yy h:mm
Formulas

A formula calculates a new value from existing values. An Excel formula can contain a
combination of constant values, cell references (cell addresses), range names, functions,
and/or operators. Formulas always begin with an equal sign (=). Here are a few

examples:

Constant Values
=(456+57)*32

Cell References

=D3/F13

Range Names

=D3*Tax

Academic Computing Services -8-
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Functions

Excel contains many predefined, or built-in, formulas, which are known as functions.
Functions can be used to perform simple or complex calculations. Some of the most
frequently used function are the SUM, AVERAGE, PMT, DLOOKUP, and IF functions.
Here is an example of the sum function adding cell addresses.

=SUM(D3:D7)

Operators

Operators specify the type of calculation that you want to perform on the
elements of a formula. Microsoft Excel includes four different types of
calculation operators: arithmetic, comparison, text, and reference.

Arithmetic
Operator Meaning
* Multiplication
/ Division
+ Addition
- Subtraction
% Percent
A Caret
Comparison
Operator Meaning
= Equals
> Greater than
< Less than
>= Greater than or equal to
<= Less than or equal to
< Not equal to
Academic Computing Services -9-

© 2002The University of Kansas



ACS Computer Training
Excel Introduction

Text
Operator Meaning
& Ampersand—Concatenates, or combines, two values
to produce one continuous text value.
Reference
Operator Meaning

Colon—A range operator, which produces one
reference to all the cells between two references that
includes the two references. An example would be
D3:D7.

Comma—A union operator, which combines multiple
references into one reference. An example would be
SUM(D3:D7,F15,B4).

Creating Formulas

There are a couple of ways in which you can create formulas. You can type the formulas
directly into the cell or formula bar; you can use Excel’s built in Formula Palette; type a
formula directly into a cell; or use AutoSum to add a group or range of numbers.

Paste Function and the Formula Palette

The formula palette (which is under the Paste Function button % o1 the Standard
toolbar) can help you enter worksheet functions. As you enter a function into the
formula, the Formula Palette displays the name of the function, each of its arguments, a
description of the function and each argument, the current result of the function, and the

current result of the entire formula. To display the Formula Palette:

1. Click inside of the cell where you want your results of the formula to be.

2. Click on the Paste Function button Fe )
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Paste Function [ 7] |

Function categary: Function name:
Most Recently Used =] |roumoUP |=]
Al SIGM
Financial SIM
Dake & Tirme SINH
SORT
Skatistical SUETOTAL
Lookup & Reference
Database SUMIF
Text SUMPRODUCT
Logical T |5UMsg
Information =] |sumzzrrz ||

SUM{number1,numberz,...)
Adds all the numbers in a range of cells,

Ok I Zancel

3. Choose the Function Category on the left side of the dialog box.

4. After choosing the category, pick which function you want from the Function Name
on the right side of the dialog box.

5. Double click on the name of the function or click on OK.

6. When the Formula Palette opens, the function’s arguments will appear.

1ra

Mumber1 || j‘_‘ =
Murberz I :s_j =

#dds all the numbers in a range of cells.

Mumber1: numberl,numberZ, ... are 1 to 30 numbers to sum, Logical values and kext
are ignoted in cells, included if typed as arguments,

Farmula result = [8]4 I Cancel

Note: When you click inside of the blank field beside each function name, a
description of each function will appear at the bottom of the Formula
Palette.

7. Fill in the arguments and click OK. The Formula Palette will close and return you
to your spreadsheet with the results in your cell. The formula will appear in the
Formula Bar.

Typing the Formula Directly in a Cell

You can also type a formula directly into a cell. To do this:
1. Activate the cell where you want the results to appear by clicking on it.

2. Type in the = sign.
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3. Type in the remaining parts of your formula.

4. When finished, press Enter on your keyboard or click on the green checkmark on
the Formula Bar.

| SUM F R = =SB R1)

Using AutoSum

Excel’s AutoSum feature is a very handy button used to add a group of numbers or range
of cells together. To use AutoSum, simply click in the cell that you want the value of the

group of numbers to appear in, click on the AutoSum button z, readjust the formula by

typing or clicking and dragging the mouse, and press Enter on your keyboard to finish
the formula.

Editing & Deleting Formulas

You can also edit or delete any formulas. To delete a formula, simply click on the cell
that contains the formula, and press the Delete key on your keyboard. If you find you
just need to alter the formula, do the following:

1) Click on the cell that contains the formula.

2) Click on the Equal button on the Formula Bar.

L B =] |

i) If the formula uses a built in Excel function, the Formula Palette will open for
you to edit the arguments.

(a) Change the appropriate argument(s) and click OK or press Enter on your
keyboard.

i1) If the formula does not use a built in function, a small dialog box will appear.
S || % | =] =B3+B9+E10]
Formula result =333 ok Cancel

(a) Click in the Formula Bar and change the formula.

(b) Click the OK button.

Note: To edita formula, you can also click on the cell that contains the
formula and then click inside of the Formula Bar and make your
changes. If you want to edit the formula directly inside of the cell, you
can double click on the cell that contains the formula.

Copying Formulas and Values

There are several ways to copy and paste formulas or their values. You can always use

the copy and paste e buttons on your Formatting toolbar, but you can also use a
feature unique to Excel called Autofill.
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Autofill

Autofill is a great way to copy a formula to other adjacent cells. To use the Autofill
feature, do the following:

1. Click on the cell whose formula you want to copy.

2. Place your mouse in the lower right corner of the cell. Your puffy plus (cross) will
turn into a skinny plus.

E3 Microsoft Excel - Book1

J File Edit “iew Insert Format Tools Data Window Help

DRSS R R v &= A
AutoFill Symbol—_| E‘?A |j - I=| —

R —

M| e | | Pl | —

3. Click and drag the skinny plus to the adjacent cells where you want the formula to be
copied.

4. When you release the click, the results will appear in each cell.

When you copy a formula to other cells using the Autofill method, you are using what is
known as a relative reference or an absolute reference, dependent upon the type of
formula you copied.

Relative References

If you create relative formulas, references to cells or ranges are based upon their position
relative to the cell that contains the formula. When you copy a formula that uses relative
references, Excel automatically adjusts the references in the pasted formula to refer to
different cells relative to the position of the formula. For example if you copy a formula
=SUM(A11:D11) from E11 to E12, then the formula will adjust to =SUM(A12:D12).

Ed Microsoft Excel - Book1

J File Edit Mjew Insert Format Tools Dakta Window Help Acrobat

DzEHs gl zr<d -z & 8% BB

E11 | =| =SUM{AT1:D11)
A | e | ¢ | o | E | F |
1
2
3
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Absolute References

If you create absolute formulas, then you are telling Excel that you do not want the
formula to adjust when copying it to a different location. The way to create this type of
reference is by placing a dollar § sign before the parts of the formula you do not want to
change. For example is your formula is =$C$13*D3 and you copy the formula from D4
to E4, only the second part of the formula would adjust to say =$C$13*E3.

Ed Microsoft Excel - Book1

J File Edit Miew Insert Format Tools Daka Window Help Acrobat

DS &6 R o-

@z AR

aumM

| *| X/ =|=5C513D3

A,

B |

C

__E | F |

—_

P2

Copying Values

Sometimes, you might only want to copy the cell result or value instead of the formula.
To do this, you can do the following:

1. Click on the cell whose value you want to copy.

2. Click on your copy button or Edit=>Copy.

3. Activate the cell you want to copy the value to by clicking on it.

4. Click on Edit=>Paste Special....

Paste Special EH |

Paste
ol = Comments
i~ walidation

" Faormulas

" &l except borders

" Formats ™ Column widths
Operakion

' Mone " Mulkiply

" ndd i~ Divide

i~ Subkract

[ Skip blanks [ Transpose

Paste Link. |

[ |

Cancel

5. Inthe Paste Special... dialog box under Paste at the top, choose Values.

6. Click OK.

7. When you look in the formula bar, you should only see the value you just copied, not

the formula.

Academic Computing Services
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Changing the Workbook or Worksheet Appearance

You can also change the appearance of worksheets and workbooks by renaming, moving,
copying, inserting, and deleting worksheets; inserting and deleting cells, columns, and
rows; and formatting the worksheets themselves.

Workbook Maintenance

Often times, we need to add, delete, rearrange, and name worksheets in our workbooks.
Keeping our workbooks organized can help us find our information quickly and easily.

Naming Worksheets
To name a worksheet something other than the default, you can do the following:
1. Place the mouse pointer directly on the worksheet tab you want to rename.
2. Double click to highlight the name of the sheet.

3. Type over the existing name and press Enter or click anywhere in the worksheet.

Adding Worksheets

To add a new worksheet to your workbook, do the following:

1. Click on the sheet tab that you want the new worksheet to come before.
2. Click on Insert=»Worksheet.

3. The new worksheet will appear.
4.

Rename the worksheet as needed.

Rearranging Worksheets

There are a couple of ways in which you can rearrange worksheets. One way would be to
move it within the same workbook and another would be to move or copy it to a different
workbook.

Moving a sheet within a workbook

To move a spreadsheet to a different location in the same workbook, you can do the
following:

1. Point at the sheet tab you want to move with your mouse pointer.

2. Click and drag the sheet tab. As you do this, you will see what looks like a piece of
paper and a small black arrow.

3. Continue to drag the sheet until the arrow points to the place you want to move the
sheet.

4. When you let go of the click, the sheet will be moved.
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Copying (or moving) a sheet to an existing workbook

To copy or move a spreadsheet to an existing workbook, you can do the following:

1.
2.
3.

Open the workbook whose sheet you want to move or copy.
Open the existing workbook that you want to move or copy your spreadsheet to.

Click on the Window menu and click the name of the workbook whose sheet you
want to copy. This will switch you back to that workbook.

Click on the sheet tab you want to move or copy.

Click on Edit<»Move or Copy Sheet....

Move or Copy EHE |

Move selected sheets
To boak;

T -

Before sheet:

Plain Warksheet
Farmatted \Warksheet
(move bo end)

-

o Creakte a copy

| Ik I Cancel |

Note: To copy the sheet, but not move it, make sure you check the box in the

corner of the Move or Copy dialog box that says Create a copy.
Otherwise, you will move the sheet instead of copying it.

When the move or copy dialog box opens, choose the name of the workbook you
want to move or copy your sheet to from the To Book: drop down list.

Click on the sheet name you want to want to move or copy the sheet in front of from
the Before Sheet: box.

Click OK.

Excel will switch you to the other workbook. Make sure you save your changes
before closing the book you just moved or copied to.
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Deleting Worksheets

You can also delete worksheets you no longer need from your workbooks. Make sure
that you only delete sheets you know for sure you no longer need or want. When you
delete an Excel spreadsheet, it is permanent. Here are the steps for that:

1. Click on the sheet tab of the worksheet you want to permanently delete.

2. Click on Edit=»Delete Sheet. A dialog box will appear to confirm the deletion.

Microzoft Excel Ed |

The selected sheet(s) will be permanently deleted,

+ To delete the selected sheets, click QK.
+ To cancel the deletion, click Cancel,

Cancel |

3. Click OK to permanently delete the entire worksheet. If you change your mind and
decide not to delete the spreadsheet, click Cancel.

Worksheet Maintenance

There might be times when you need to add or delete cells, rows, or columns to your
worksheets. All of these things can be easily done.

Adding or Deleting Cells

Sometimes you might find that you need to add or delete a cell or several cells from your
worksheet. To do this, you can do the following:

1. Select the cell or range of cells you want to insert cells before or delete.
2. To add cells before these cells, click on Insert=»Cells....
i.)  The Insert Cells dialog box will open.

Insert [ 7] |

Inzert

= Shifk cells dawn

" Entire (a1t
" Entire column

(04 I Cancel

ii.)  Choose the option you want and click OK.
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3. To delete cells before these cells, click on Edit=»Delete.
i.) A Delete dialog box will open.

Delete |

Delete

.................................

" shift: cells up

" Entire (a1t
" Entire column

(04 I Cancel

ii.)  Choose the option you want and click OK.

Adding or Deleting Rows and Columns

You can also choose to add or delete entire rows or columns from your spreadsheet. If
this is what you need, do the following:

1. Select the column letter or row number that you want to insert the entire row or
column before or delete.

2. To insert a column before the one you’ve chosen, click on Insert=»Column. If you
clicked on a row instead, click on Insert=»Row.

3. To delete the column or row you’ve chosen, click on Edit=»Delete.

Formatting Worksheets

There are several ways to format your Excel worksheets, whether you’re trying to format
the cells or the cell contents. One way is to the Formatting toolbar or the format dialog
box. Another way is to use a feature called AutoFormat. The AutoFormat option is a
great way to format you’re spreadsheet quickly. Even if you choose this option, you can
still change any formatting you don’t like that AutoFormat added.

Formatting Toolbar and Dialog Box

The Formatting toolbar and dialog box are two ways to nicely format your worksheet.
Using either option you will find things such as the following:

¢ Formatting numbers
e Changing the font, color, size and alignment
¢ Changing the cell colors and/or patterns.

e Adding borders to cells
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To utilize the features on the Formatting toolbar, simply make the cell or group of cells
you want to format active by clicking on them, and click on the button(s) you want to use
to make your changes. The Formatting toolbar looks like this:

J.ﬁ.rial -0 - B 7 U =

= =4 4.0 .00
= | $ % 1 L0 .0

E.

i
Ak
i

If you want more options than what the Formatting toolbar offers, then use the Format
Cells dialog box instead. Make sure you click on the cell or groups of cells you want to
format and then click Format=>Cells.... When the Format Cells dialog box opens, you
will notice that there are six different tabs you can choose options from: Number,
Alignment, Font, Borders, Patterns, and Protection. Make any changes you need to and
then click on OK. Here is a picture of the Alignment tab in the Format Cells dialog box:

Format Cells EH |

Mumber | Fonk | Border I Patterns | F‘r-:ul:e-:l:il:unl
Texk alignment —Crienkakion
Horizontal: Indent: + .
IGeneraI j ID ﬂ *.
T .
Wertical: e Text —&
x .
IEh:uttu:um j I .
*
.
Text conkraol ||:| 3‘ Degrees
o Wrap text
[ Shirink to Fit
[ Merge cells

| Ik I Zancel

Note: On the Protection tab, you’ll notice the note that says locking cells or
hiding formulas will only work if the worksheet is protected.
Protecting worksheets is not covered in this class. It will be covered in
the Excel: Functions and Data Analysis Tools workshop.
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AutoFormat

Excel’s AutoFormat feature is a great way to quickly format your worksheet. To use it,
do the following:

1. Select the group of cells you want to format.

2. Click Format=>AutoFormat....

AutoF ormat

0l
x|

K

Gan Feb Mar Totsl Jan  Feb  Mar  Total
East 3 73 73 53 13 [Eest § 79 73 5319 —
West G 4 7 17 | wiest G 4 7 17
South 5 7 9 24

South g 7 9 24 ;

Total § 1% 183 1% 80 yote) § 27§ 1855 21 § 60 Seens.

Accounting 3 Accounting 4

Jan  Feb Nar Total

East i ' ik Fast 7 7 5 19

Wost ] 4 ! 17 Wast B 4 T 17

Sounth g T g 24

Total 21 18 21 G0

Colorful 1 Colorful 2

Jan Fed Mar Total Jan_Feb Mar Total

T T 5 19 v T 5 19

G 5] q 7 17

0 5] T g 24

Total 21 g 18 g [0
Colorful 3 Lisk 1 |

3. The AutoFormat dialog box will open for you to change to the format you like by
clicking on the pictures. Use the scroll bar on the right side to scroll through.

4. If you want to change any of the formatting options, click on the Options... button in
the AutoFormat dialog box.

5. Once you find a format you like, click on it and then click OK to format your cells
and close the dialog box.
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Clearing Formats
If you decide you don’t like the format you’ve chosen for your cells, you can quickly
clear the format without deleting the contents of the cells. To do this:

1. Select the groups of cells whose format you want to clear.

2. Click on Edit=»Clear=>Formats.

Make sure you only choose Formats. If you choose All or Contents,

Note:
you will delete the information as well. If this accidentally happens,

just click on your Undo button **7 or click Edit=»Undo and
everything will reappear.

3. The format of your cells will be changed back to Normal but the information will still

be there.
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Getting Additional Help

Academic Computing Services provides consulting and Q&A help in a variety of ways:

785/864-0200
question@ku.edu
www.ku.edu/acs/help

To evaluate this course online, please visit www.ku.edu/acs/training/evaluation.

Last Update: 05/10/2002
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